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Reliance 4 – Runtime Software

1  Introduction

In the context  of  Reliance,  runtime  software  is  a  program designed  to  run  a  visualization
project  on the end user's computer. Runtime software  is  a  common  term for the  following
programs: Reliance 4 View, Reliance 4 Control, Reliance 4 Control Server and Reliance 4
Server.  The  last  mentioned  program doesn't  have  a  graphical  user  interface  (GUI)  and  is
intended  to  run  as  a  Windows  service.  When  a  visualization  project  is  run  on  multiple
computers, an identical copy of the project must be present on each computer. A visualization
project on a specific computer is usually started via a shortcut. For additional information on
how to start a project and how to create a shortcut file, see the Appendix section.

Reliance 4 – Factory Demo
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2  Runtime Software Description

All kinds of runtime software that have a graphical user interface (GUI) provide the user with
the same commands and functions, which can be accessed through the Main menu or the
Toolbar.  Other functions  of  a  visualization  project  are  provided  by  means  of  Components
embedded into visualization windows when the project was created. 

Reliance 4 – AirCondition Demo
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2.1  Main Menu

The  menu  contains  commands  for  accessing  basic  commands  (functions)  of  the  runtime
software. For example, these are commands for running a visualization project, logging a user
on  to  the  program,  accessing  trends  and  reports,  changing  the  language  and  invoking
diagnostic tools. The  following  text  describes  all  commands  accessible  via  this  menu.  The
most  frequently  used commands are also available in  the  Toolbar.  In  this  text,  the  toolbar
commands are indicated with an appropriate icon next to command name.

Reliance 4 – File and Help Menu

File menu

View menu

Managers menu

Tools menu

Window menu
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Help menu

2.1.1  File Menu

  Run Project

Opens and starts the selected visualization project (the command is enabled only  if  the
runtime software has been started without parameters). To start another project when a
project is already running, the runtime software has to be closed and started again.

  Log On User

Shows a dialog window where the user can enter his/her user name and password to log
on  to  the  program.  After a  successful  logon,  user  settings  are  loaded  (e.g.  language
version and settings of alarm/event viewers). For more information on this topic, see the
chapter Logging on/off.

  Log Off User

Logs off the current user and loads the Default settings.

  Logged-On User Information

Brings up the Information dialog with the name of the currently logged-on user.

  Project Language

Brings up the Select Project Language dialog. If there are multiple languages defined in
the project, the user can switch between these languages.

  Program Language

Brings up the Select Program Language dialog which contains a list of runtime software
languages. The user can switch the language of  the program's GUI (text  in the menus,
toolbars, alarm/event viewers, trend viewer, etc.).
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  Print Main Window

Brings up the standard Windows print  dialog which allows you to select  a  printer and
configure print settings in order to print the image of the program's main window.

  Exit

Exits the runtime software.

2.1.2  View Menu

  Current Alarms/Events

Displays a list of current alarms/events which are those that are still active or have not yet
been acknowledged. For additional information see the chapter Alarm/event viewers.

  Historical Alarms/Events

Displays a list of historical alarms/events which are those that are stored in a database.
The database contains alarms/events defined in the project and operating events, such
as starting and terminating the project, logging users on and off the program, losing and
restoring connection with other computers and devices, etc. For more information on this
topic, see the chapter Alarm/event viewers.

 Defined Alarms/Events

Displays a list of alarms/events defined in the project. For additional information see the
chapter Alarm/event viewers.

  Trend

Displays a list of available Trends. A trend selected in the list is afterwards displayed in
the trend viewer. A trend can also be printed or exported to various formats through the
trend viewer. The data for trends is stored in data tables (databases).
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  Report

Displays a list  of  available Reports. A  report  selected  from the  list  is  displayed  in  the
report viewer. A report can also be printed or exported to various formats with the report
viewer. The data for reports is stored in data tables (databases).

  Custom Report

Displays  a  list  of  available  Custom reports.  A  custom  report  selected  from  the  list  is
displayed in the custom report viewer. A custom report can also be printed, exported to
various formats or e-mailed by  means of  the custom report  viewer. Custom reports  are
designed to generate reports based on custom templates.

2.1.3  Managers Menu

  Trend Manager

Brings up the Trend Manager which allows you to define and configure trends. 

  Report manager

Brings up the Report Manager which allows you to define and configure reports.

  User Manager

Brings up the User Manager which allows you to define and configure users.

  Project Manager

Brings up the Project Manager which shows information about all objects defined in the
project (e.g. devices, tags, alarms/events, data tables, etc.).

2.1.4  Tools Menu

  Virtual Keyboard

Brings up a Virtual Keyboard which enables the user to type text even on the computers
without a keyboard. The Virtual Keyboard window is always on top. The Virtual Keyboard
function has to be activated when developing a visualization project.
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  Recipe Editor

Opens a tool for working with Recipes.

  Postmort Record Player 

Brings up the Postmort Record Player which allows you to replay the process visualization
from a chosen time.

  Server Web Page

Opens  the  main  page  of  the  built-in  Web  server  in  the  default  Web  browser.  This
command is only available in Reliance 4 Control Server.

  System Information

Displays  the  System  Information  window  which  shows  information  about  connected
devices, tags, data tables, server connections, DDE sharing, etc.

2.1.5  Window Menu

  Previous Window

Shows the previously shown window. The user can go at most 10 previous windows back.

  Next Window

Shows  the  next  window.  The  command  can  be  used  after  the  Previous  Window
command.

  Records Related to Active Window

Displays  a  list  of  records  (text  notes)  made  by  the  users  for  the  active  visualization
window.  For example  an  operator working  in  the  first  shift  can  leave  a  note  about  a
problem in the visualized process for the operator working in the second shift. The user
can create and edit records only when he/she is logged on.



9Main Menu

Reliance 4 – Runtime Software

  Records Related to All Windows

Displays  an  overall  list  of  records  (text  notes)  made  by  the  users  for  all  visualization
windows.

2.1.6  Help Menu

  Contents

Opens a help document for the Reliance runtime software in the CHM format.

  License

  Activate

Brings  up  the  Activate  License  Wizard  where  you  can  activate  your  SW  license.  The
command is disabled in case an HW key (dongle) is connected. For detailed information,
see the LicenseActivation document.

  Register

Brings up a dialog where the user can select a registration file. A registration file contains
the user and company names. It can be created with License Key Utility. The utility is part
of  Reliance  4  and  it  is  located  in  the  <Reliance4>\Utils\LicenseKeyUtil
directory  upon  installing  the  software.  The  registration  information  is  shown  in  the
program's  About  box.  The  command  is  only  visible  if  the  software  has  not  yet  been
registered.

  Information

Opens License Key  Utility  to show the information stored in the license key. Microsoft  .
NET Framework 3.5 is required to run the utility.
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  About Reliance 4 View/Control/Control Server

Brings up the program's About  box, i.e., a dialog box  showing the version  and  type  of
runtime  software,  maximum  number  of  licensed  data  points,  computer  system
information, memory usage, registration information, etc. Click the Serial number label to
show the license detection method or launch License Key  Utility  to view the information
stored in the license key.
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2.2  Toolbar

The toolbar of the runtime software contains the most commonly used commands. All of them
can also be accessed through the > File menu.

Reliance 4 – Toolbar

The toolbar is located just below the main menu and contains the following commands:

  Previous Window

Shows the previously shown window. The user can go at most 10 previous windows back.

  Next Window

Shows  the  next  window.  The  command  can  be  used  after  the  Previous  Window
command.

  Log On User

Shows a dialog window where the user can enter his/her user name and password to log
on  to  the  program.  After a  successful  logon,  user  settings  are  loaded  (e.g.  language
version and settings of alarm/event viewers). For more information on this topic, see the
chapter Logging on/off.

  Log Off User

Logs off the current user and loads the Default settings.
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  Historical Alarms/Events

Displays a list of historical alarms/events which are those that are stored in a database.
The database contains alarms/events defined in the project and operating events, such
as starting and terminating the project, logging users on and off the program, losing and
restoring connection with other computers and devices, etc. For more information on this
topic, see the chapter Alarm/event viewers.

  Current Alarms/Events

Displays a list of current alarms/events which are those that are still active or have not yet
been acknowledged. For additional information see the chapter Alarm/event viewers.

  Trend

Displays a list of available Trends. A trend selected in the list is afterwards displayed in
the trend viewer. A trend can also be printed or exported to various formats through the
trend viewer. The data for trends is stored in data tables (databases).

  Report

Displays a list  of  available Reports. A  report  selected  from the  list  is  displayed  in  the
report viewer. A report can also be printed or exported to various formats with the report
viewer. The data for reports is stored in data tables (databases).

  Custom Report

Displays  a  list  of  available  Custom reports.  A  custom  report  selected  from  the  list  is
displayed in the custom report viewer. A custom report can also be printed, exported to
various formats or e-mailed by  means of  the custom report  viewer. Custom reports  are
designed to generate reports based on custom templates.

  Records Related to Active Window

Displays  a  list  of  records  (text  notes)  made  by  the  users  for  the  active  visualization
window.  For example  an  operator working  in  the  first  shift  can  leave  a  note  about  a
problem in the visualized process for the operator working in the second shift. The user
can create and edit records only when he/she is logged on.
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  Records Related to All Windows

Displays  an  overall  list  of  records  (text  notes)  made  by  the  users  for  all  visualization
windows.

  Virtual Keyboard

Brings up a Virtual Keyboard which enables the user to type text even on the computers
without a keyboard. The Virtual Keyboard window is always on top. The Virtual Keyboard
function has to be activated when developing a visualization project.
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2.3  Components

Components are graphical objects embedded into visualization windows. Some components
are designed to display  real-time data (i.e. the values of  tags defined in  a  project;  e.g.  the
Display  component can show a numerical or text value). The properties of  most  components
can be dynamically controlled by tags (e.g. component visibility, position, size, color, etc.).

Every  tag  has  a  special  attribute  – quality.  The  tag  quality  can  be  either good  or  bad.  A
component linked to a tag that has a quality other than good is indicated with a yellow border
around the component. This applies to any tag affecting the component whether its value is
displayed by the component or controls the component's visibility, position, size, etc. The tag
quality  is bad for example if  an error occurs  in  communication  with  a  device  (PLC)  or if  a
project  has  just  started  and  the  values  of  tags  have  not  yet  been  returned  by  the
communication driver.

Red frame – invalid link
Yellow frame – invalid data

A red border around a component indicates an invalid link to a tag (a missing link or link to a
tag that was later deleted). A red border usually indicates a problem in project design.

Short help (hint) can be displayed when mouse cursor is positioned over the component.

By  clicking on  a  component,  the  user can  open  another window,  activate  a  Popup  menu,
execute an Action, run a Script  or perform some other operations (e.g. bring  up  the  dialog
where the user can enter a new value for a tag). The operations can be restricted using Access
rights.  The  user  won't  be  permitted  access  to  these  operations  when  his/her  rights  are
insufficient.
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2.4  Logging On/Off

The whole application can be secured against  unauthorized use by  means of  access  rights
which  can  be  assigned  to  users  defined  in  the  project  (see  the  chapter  User  Manager).
Components or commands secured  with  access  rights  are  enabled  (can  be  accessed)  only
after the user with sufficient  access rights logs on to the program. A  user can log on in the
following two ways:

Reliance 4 – Insufficient access rights

Using a name and password

Using a HW code reader

2.4.1  Logging On/Off Using a Name and Password

To log on to the program, the user must choose the > File > Log On User command or the Log
On User command from the toolbar. This brings up the Log On User dialog.

Reliance 4 – User log on
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The user must then enter his/her login name and password. 

The login name is the name defined for the user through the User Manager. It  is not  case
sensitive.

The password (also defined through the User Manager) is case  sensitive. Characters of  the
password are shown as asterisks for security reasons. 

After confirming the dialog, the name and password are verified. If they are correct, the log-on
process is completed and user settings are loaded.

To  log  off,  the  user must  choose  the  > File  > Log  Off  User  command  or the  Log  Off  User
command from the toolbar.

2.4.2  Logging On/Off Using a Hardware Code Reader

If the computer is equipped with a special hardware code reader, the user can log on to the
program by putting his/her card near the reader. The program makes a beep sound if the log-
on is successful. To log off, the user must again put his/her card near the reader.

The user can also log on by means of a fingerprint reader.
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2.5  Alarm/Event Viewers

Alarm/event viewers display a list of the occurrences of alarms/events defined in the project
and operating events, such as starting and terminating the project, logging users on and off
the program, losing and restoring connection with other computers and devices, etc.

The state of an alarm/event is indicated by the background color of the respective row in the
list:

Red background  

The alarm/event is active and has not been acknowledged.

Yellow background  

The alarm/event is active and has been acknowledged.

White background  

The alarm/event is not active and has not  been acknowledged. The alarm condition no
longer exists.

The acknowledgment state of an alarm/event is indicated by one of the following symbols:

The alarm/event has been acknowledged.

The alarm/event has not been acknowledged.

The  type  of  condition  that  triggers  an  alarm/event  is  indicated  by  one  of  the  following
symbols:

Tag data change.

Leading edge of the tag.

Trailing edge of the tag.

High critical limit of the tag.

High warning limit of the tag.

Low warning limit of the tag.

Low critical limit of the tag.
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Popup menu

To configure the list of alarms/events, right-click on the list. This brings up a popup menu
that contains the following commands:

Load User Settings

Brings up a dialog with a list of all users that have the viewer settings stored in their
profile. In addition to these users, the list can include an item named Default  which
corresponds to the default settings. These are used if the user does not yet have his/
her own settings or when no user is logged on. Upon selecting a user from the list and
confirming the dialog, the settings stored in the selected user's profile are applied.

Save User Settings

Brings up a dialog with a list  of  all users to which the viewer settings can be made
available.  In  addition  to  these  users,  the  list  can  include  an  item  named  Default
which corresponds to  the  default  settings.  The  user is  always  allowed  to  save  the
settings  to  his/her  own  profile  and  the  Default  profile.  If  the  user  has  the  User
administrator option active or is assigned the Servicing  right,  he/she  can  save  the
settings to all user profiles.

Properties

Brings up a dialog with a list of items corresponding to the available fields (columns).
The list on the Displayed fields page of the dialog allows you to select the columns to
be visible in the viewer. The Up and Down commands are used to change the column
order (the topmost checked item in the list corresponds to the leftmost column in the
viewer). The list on the Sorting page of the dialog lets you select  the columns to be
used  for sorting.  For each  selected  column,  you  can  configure  the  Order  property
(Ascending,  Descending)  which determines the direction of  sorting by  that  column.
The  position  of  items  in  the  list  determines  the  priority  for  sorting  (the  topmost
checked  item  has  the  highest  priority  –  the  sorting  will  occur  first  for  the
corresponding  column;  the  position  can  be  changed  with  the  Up  and  Down
commands).

The following lists of Alarms/Events are available in Runtime programs:

Current Alarms/Events list

Archived Alarms/Events list

Defined Alarms/Events list

Alarms/Event at bottom panel
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2.5.1  Current Alarm/Event Viewer

The  current  alarm/event  viewer can  be  displayed  with  the  > File  > Current  Alarms/ Events
command or the Current Alarms/ Events command from the toolbar. The viewer shows a list of
current alarms/events which are those that are still active or have not yet been acknowledged
(and need to be acknowledged). The list is automatically updated with new information.

Reliance 4 – Current Alarms/Events

The top part of the viewer window contains a toolbar with the following buttons (commands):

Acknowledge

Acknowledges the alarms/events selected in the list (multiple rows can be selected at  a
time).

Acknowledge All

Acknowledges all alarms/events in the list.
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Report

Opens the Alarms/Events Report Editor which is designed to prepare a report of alarms/
events. The report can be printed on the selected printer or saved to a file.

Show Details

Brings up a window  containing detailed information about  the selected  alarm/event  –
Detailed Information on Alarm/Event. The same window is displayed after double click on
an item in Alarms/Events list. This command can also be invoked by  double-clicking a
row in the list.

Show Window

Shows  a  visualization  window  associated  with  the  selected  alarm/event  (if  such  a
window was specified at design-time). This enables the user to immediately see and work
with the part of the visualization that is related to the alarm/event.

Explain

Shows an explanation (specified as the value of the Description property at design-time)
for the selected alarm/event.

Note

Brings up a dialog window  where the user can enter a note about  the selected alarm/
event. For example, an operator working in the first shift might describe the steps taken
to fix the cause of the alarm/event. Later, the operator working in the second shift  can
read the note.

2.5.1.1  Detailed Information on Alarm/Event

The Detailed  Information on Alarm/ Event  window  can be  invoked  from the  current  alarm/
event viewer to display detailed information on the selected alarm/event. The toolbar contains
the First, Previous, Next  and Last  commands for navigating through alarm/event  in the list,
and  the  Show  Window,  Explain  and  Note  commands.  For  the  description  of  the  last
mentioned group of commands, see the chapter Current  alarm/event  viewer. The status bar
displays  information  on  the  selected  alarm/event  (start  date  and  time,  status)  and  the
number of current alarms/events (total count, unacknowledged count).

Text

Text of the alarm/event.
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Comment

Comment about the alarm/event intended mainly for the visualization project  developer
(system integrator).

Type

Type of alarm/event (Alert, Command, System message).

Condition

Specifies  the  condition  that  generates  the  alarm/event  (Any  change,  Increment,
Decrement, Leading edge, Trailing edge, High/ Low critical limit, High/ Low warning limit,
Value in range).

Priority

Numerical value of the priority that affects the order in which the sound triggered by the
alarms/event's start  and end should  be  played.  The  greater the  value,  the  higher the
priority.

Tag

Name of the tag related to the alarm/event.

Log

Determines whether to log the alarm/event to a database.

Ack

Determines  whether acknowledgment  by  the  operator is  required  for the  alarm/event
before it can be removed from the list of current alarms/events.

Device

Name of the device that the alarm/event belongs to.

Ack rights

Specifies the access rights required to acknowledge the alarm/event. The user must have
at least one of the specified rights.

2.5.2  Historical Alarm/Event Viewer

The historical alarm/event viewer can be displayed with the > File > Historical Alarms/ Events
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command or the Historical Alarms/ Events command from the toolbar. The viewer shows a list
of  historical  alarms/events  which  are  those  that  are  stored  in  a  database.  The  list  is  not
automatically updated with new information. To update the list, invoke the Update command
from the toolbar. This is in contrast to the list of current alarms/events.

The list can be restricted with a time or custom filter. The list can be exported to a text file or
printed/exported as a report prepared using the Alarms/Events Report Editor.

Reliance 4 – Historical Alarms/Events

The top part of the viewer window contains a toolbar with the following buttons (commands):

Filter

Shows a menu containing commands for working with filters:

Time Filter

Brings  up  a  dialog  in  which  a  time  interval  can  be  selected.  The  interval  determines
which alarms/events should be shown in the list. For more information see the chapter
Time Filter.
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Custom Filter

Brings  up  a  dialog  for  the  definition  and  selection  of  custom  filters.  For  detailed
information see the chapter Custom Filter.

Cancel Filter

Cancels the active time or user filter. As a result, all alarms/events stored in the database
are shown in the list.

Update

Updates the list of alarms/events with new information.

Export

Brings  up  a  dialog  for  exporting  of  displayed  alarms/events  to  a  text  file.  For  more
information see the chapter Export.

Report

Opens the Alarms/Events Report Editor which is designed to prepare a report of alarms/
events. The report can be printed on the selected printer or saved to a file.

Acknowledge

Acknowledges the alarm/event selected in the list (only a single row can be selected at a
time).

Show Window

Shows  a  visualization  window  associated  with  the  selected  alarm/event  (if  such  a
window was specified at design-time). This enables the user to immediately see and work
with the part of the visualization that is related to the alarm/event.

Explain

Shows an explanation (specified as the value of the Description property at design-time)
for the selected alarm/event.

Note

Brings up a dialog window  where the user can enter a note about  the selected alarm/
event. For example, an operator working in the first shift might describe the steps taken
to fix the cause of the alarm/event. Later, the operator working in the second shift  can
read the note.
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2.5.2.1  Time Filter

The Time Filter dialog can be invoked by  choosing the  > Filter > Time Filter command from
the Historical Alarms/ Events viewer's toolbar.

Filtered fields:

Specifies  which  time  stamp  (date  and  time)  field  is  filtered  (Start,  End,  Receipt,
Acknowledgment, Note).

From:

The timestamp (date and time) of the oldest alarm/event meeting the filter condition.

Till:

The timestamp (date and time) of the latest alarm/event meeting the filter condition.

2.5.2.2  Custom Filter

The Custom Filter dialog enables the user to select an existing Custom Filter or to create a new
 Custom Filter. The dialog can be invoked by choosing the > Filter > Custom Filter command
from the Historical  Alarms/ Events viewer's toolbar.  The  top  part  of  the  window  contains  a
toolbar with commands used to create and edit  a custom filter. The left  part  of  the window
contains a list of fields which can be used to construct a logical expression. The right part  of
the window contains the constructed logical expression which will be used to filter the list of
alarms/events.

A logical expression is constructed from terms. A term consists of a field selected from the list
on the left, a comparison operator and a value. The field can be added by choosing the Add
Field command, the comparison operator can be selected from the toolbar (< Less, > Greater,
or = Equal) and the value can be specified through a dialog invoked by  choosing the Enter
Value command.

More complex expressions can be constructed with the help of the logical operators and, or.
For better orientation, each term of a logical expression should be enclosed in parentheses.

Toolbar

Filter

Shows  a  menu  for working  with  custom  filters.  The  menu  contains  the  following
commands:
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New

Creates a new custom filter.

Select

Brings up a dialog with a list of already defined and saved custom filters.

Save

Saves the current custom filter to the profile of the user selected in the left column. If
the filter has not yet been saved (new filter), the Save As command is invoked.

Save As

Brings up the Save Filter dialog to save the current custom filter using a new name.

In addition, the toolbar contains the following commands:

and

Adds an  and  operator (logical  conjunction)  to  the  expression.  All  terms  connected
with this logical operator have to be true in order for an alarm/event to be included in
the list. Otherwise, it is filtered out of the list.

or

Adds an or operator (logical disjunction) to the expression. At  least  one of  the terms
connected with this logical operator must  be true in order for an alarm/event  to be
included in the list. Otherwise, it is filtered out of the list.

Left Parenthesis

Adds  a  left  parenthesis  to  the  expression.  It  is  strongly  recommended  to  use
parentheses for better clarity of longer expressions.

Add Field

Adds the selected field from the list on the left side to the logical expression.

Less

Adds a less than operator (<) to the logical expression.

Greater

Adds a greater than operator (>) to the logical expression.
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Equal

Adds an Equal to operator (=) to the logical expression.

Enter Value

Brings up a dialog where the user can enter the  value  that  restricts  the  preceding
field. The value can be added only after the Less/ Greater/ Equal operators.

Right Parenthesis

Adds  a  right  parenthesis  to  the  expression.  It  is  strongly  recommended  to  use
parenthesis for better clarity of longer expressions.

Change Value

Brings up a dialog where the user can change the value that  restricts the preceding
field.

Delete Last

Deletes the last item of the expression (field, value, parenthesis, etc.).

Undo

Reverts the last operation performed by the Delete Last command.

Item list

Start date

Date when an alarm/event started (was generated).

Start time

Time when an alarm/event started (was generated).

Text

Text of an alarm/event. The filter condition does not require the whole text.

Condition

Condition that generates an alarm/event (Data change, Leading edge, Trailing edge,
etc.).
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Priority

Priority of an alarm/event.

Device

Name of the device that an alarm/event belongs to.

Tag

Name of the tag related to an alarm/event.

Computer

Name of the computer on which an alarm/event was saved to the database.

User

Name of the user logged on when an alarm/event was received.

Ack

Whether an alarm/event requires acknowledgment.

Ack rights

Access rights required for alarm/event acknowledgment.

Acked

Whether an alarm/event has been acknowledged.

Ack date

Date when an alarm/event was acknowledged.

Ack time

Time when an alarm/event was acknowledged.

Ack user

Name of the user who acknowledged an alarm/event.

End date

Date when an alarm/event ended.
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End time

Time when an alarm/event ended.

Receipt date

Date when an alarm/event was received by the runtime software. An alarm/event may
be received from a device or another instance of  the runtime software (data server)
later than it started.

Receipt time

Time when an  alarm/event  was  received  by  the  runtime  software.  An  alarm/event
may  be  received  from a  device  or another instance  of  the  runtime  software  (data
server) later than it started.

Type

Type of alarm/event (Alert, Command, System message).

Active

Whether an alarm/event is still active.

Start date and time

Date and time when an alarm/event started (was generated).

End date and time

Date and time when an alarm/event ended.

Receipt date and time

Date and time when an alarm/event was received by the runtime software.

Ack date and time

Date and time when an alarm/event was acknowledged.

Note date and time

Date and time when the note related to an alarm/event was entered or last modified.

Tag value

The tag value that generated an alarm/event.
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Note

Text of the note related to an alarm/event. The filter condition does not  require the
whole text.

Example

It  is required to display  only  the alarms/events that  occurred since  4/6/2007,  6:00 AM
(excluding) to 4/25/2007, 6:00 PM (including) and that are no longer active.

The  filter  expression  consists  of  three  logical  conditions  (terms).  Each  term  will  be
enclosed in parentheses.

Choose the Left Parenthesis command, select the Start date and time field from the list on
the left and invoke the Add Field command. Insert a greater (>) operator and choose the
Enter  Value  command  to  enter  a  date  and  time  (select  4/6/2007,  6:00  AM).  Then
complete the term with a right parenthesis.

Choose the logical And command and create the second part of the expression in the same
manner. Insert a left parenthesis, select and insert the End date and time field, insert less
and equal operators, and a date and time (select  4/25/2007, 6:00 PM). Then complete
the term with a right parenthesis.

Choose the logical And command and create the third part of the expression in the same
way. Insert a left parenthesis, select and insert the Active field, insert  an equal  operator,
and a boolean value (select False). Then complete the term with a right parenthesis.

The logical expression is completed. It is advised to save the filter with the > Filter > Save
As command before first  using it. Close the Custom Filter dialog  with  the  OK  button  to
apply the filter to historical alarms/events.

2.5.2.3  Export

Exports the list of displayed alarms/events or report data to formatted text file (CSV) so that it
can be further processed with third party applications (MS Excel, etc.).

Target file

Specifies whether to create a new file or append the exported text at the end of the target
file.

Item delimiter

Specifies  a  character to  be  used  to  delimit  the  exported  items  (Space,  Tab,  Comma,
Semicolon or another user defined character(s)).
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After closing the dialog with the OK button, specify the name of the target file in the Save As
dialog.

2.5.3  Alarm/Event Report Editor

The Alarm/ Event Report Editor dialog can be displayed when the Report command from the
current and historical alarm/event viewers is invoked. The editor window contains two pages –
 Report elements and Report rows. The Report elements page defines the parts (headers and
a footer)  making up the report  and their properties. The  Report  rows  page  specifies  report
rows properties (height, font, grid).

Report elements page

Report elements

Report header

Specifies whether the first page of the report should contain a header.

Page header

Specifies whether each page of the report should contain a header.

Column header

Specifies whether each page of the report  should contain a column header (located
right below the Page header).

Page footer

Specifies whether the bottom part of each page should contain a footer.

Properties

Height

Height of the selected header or footer (in pixels).

Text

Text of the selected header or footer.

Alignment

Specifies the text position. The text can be aligned to the Left, Right or Center of the
page or the column.
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Font

Brings  up  a  font  selection  dialog.  The  selected  font  will  be  used  for  printing  the
selected header or footer.

First page header

Specifies whether the Page header should be also printed on the first  page  of  the
report.

Čísla stránek

Specifies whether the Page footer should contain Page numbers.

Report rows page

Height

Height of the report rows.

Font

Brings up a font selection dialog. The selected font will be used for printing the text in
report rows.

Grid 

Specifies which lines of  a grid  should be displayed. The visibility  of  horizontal  and
vertical lines can be configured separately.

2.5.4  Defined Alarm/Event Viewer

The defined alarm/event  viewer can be displayed  with  the  > File  > Defined  Alarms/ Events
command. The viewer shows a list of devices defined in the project. For each device, a list of a
larms/events  can  be  displayed.  Selected  alarms/events  can  be  temporarily  disabled
(inhibited).

The top part of the viewer window contains a toolbar with the following buttons (commands):

View

Shows a menu containing the following commands:

Device List 

Displays a list of connected devices.
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Alarm/ Event List

Displays a list of alarms/events defined in the selected device.

Enabled Alarms/ Events

Specifies whether enabled alarms/events should be displayed in the list.

Disabled Alarms/ Events

Specifies whether disabled alarms/events should be displayed in the list.

Up

Displays a list of connected devices if the list of alarms/events is displayed.

Sort

Sorts  defined  alarms/events  by  the  specified  criterion  (Type,  Condition,  Tag,  Priority,
Text).

Disable

Disables generating selected alarms/events. This feature has to be activated through the
development environment (the Proj ect Options dialog), where required access rights can
also be configured.

Enable

Enables generating selected alarms/events. This feature has to be activated through the
development environment (the Proj ect Options dialog), where required access rights can
also be configured.

Disable online printing of Alarms/Events

Disables/enables the online printing of  alarms/events. To change this option, the user
must  have  the  same  access  rights  as  are  required  for  enabling/disabling  generating
alarms/events through the above commands.

2.5.5  Alarms/Events in the Bottom Panel

Current  alarms/events can also be  displayed  in  a  panel  located  in  the  bottom part  of  the
runtime software's main window. The panel shows the type and text  of  the selected alarm/
event (a name of the device can be displayed, too). An alarm/event can be selected by using
arrow buttons located on the right  side of  the panel. If  the arrow  buttons are not  used, the
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selected  alarm/event  is  always  the  last  received/generated  one.  The  panel  also  contains
buttons  for  alarm/event  acknowledgment  and  hiding  the  panel.  After  hiding,  the  panel
remains invisible until a new alarm/event that requires acknowledgement is generated.

Reliance 4 – Alarms/events in the bottom panel
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2.6  Trends

Trends (sometimes called historical trends) are used to view  historical data in the form of  a
trend chart  with a bottom time axis. Historical data is the data of  tags stored (along with a
time stamp) in data tables (databases). A trend consists of one or more series. A  series is a
sequence of points (values of a tag, each with a time stamp). The data shown by  a trend is
usually stored in one data table, but it is possible to show data from any number of different
data tables in a single trend. The visual appearance of a trend can be adjusted by  means of
many  parameters. Every  user defined in a project  can have his/her own settings  of  trends.
Trends can be displayed with a tool called trend viewer.

Reliance 4 – Trend viewer

Trends  can  be  defined  through  a  tool  called  Trend  Manager  (defined  trends).  A  list  of
available defined trends can be accessed via the > File > Trends command.
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Besides defined trends, a tag trend is available to display historical data of a single tag. A tag
trend  can be displayed by  choosing the Show Trend  command from the popup  menu  of  a
display  component placed in a visualization window. A  tag  trend  is only  available if  the tag
displayed by  the component  is stored in a data table. If  the  tag  is  stored  in  multiple  data
tables, the data table  with  the  most  frequent  sampling  is  automatically  selected.  Possible
changes made to trend settings are saved but not for a particular tag. These settings will be
applied even when showing a trend of any other tag (except for vertical axis range settings).

Trend viewer

Trend manager

2.6.1  Trend Viewer

The trend viewer is a tool designed for displaying historical data in the form of a chart with a
bottom time axis. It allows for fluently browsing data with the step of various size (1 page, half
a page, dragging with the mouse).

The viewer can be opened as a stand-alone window  or a window  embedded into the  main
window  of  the runtime software. The way  of  opening the viewer is  controlled  by  the  Insert
trend window into main window option in the list of available trends. If  the option is active,
the viewer gets embedded into the main window  in the way  allowing the user to move the
viewer window and change its size. In this case, the viewer behaves as a sizeable stay-on-top
visualization window  with a title bar. This way, it  is possible to view  multiple trends at  the
same  time.  If  the  Insert  trend  window  into  main  window  option  is  not  active,  the  viewer
window  opens maximized and covers up  (obscures)  the  main  window.  The  viewer window
opened this way cannot be moved and resized. Therefore, the viewer must  be closed before
the user can continue to work with other parts of the application.

The top part of the viewer contains a toolbar for working with the trend. The actual trend is
displayed  in  the  area  below  the  toolbar.  In  the  bottom  part  of  the  area,  a  time  axis  is
displayed. In the left part of the area, one ore more vertical axes are displayed.

The toolbar contains the following commands:

Scroll trend - single arrows

Scrolls the trend view forward by half a page. A page represents a predefined time range
or the number of points.
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Scroll trend - double arrows

Scrolls the trend view forward by one page. A page represents a predefined time range or
the number of points.

Ruler

Allows for showing/hiding the ruler. If this option is active, a vertical straight line (called
ruler) is displayed in the nearest point (point with the nearest time stamp in any series).
The ruler can  be  moved  to  the  nearest  neighboring  point  using  arrow  buttons  in  the
toolbar or using arrow keys (left and right) on the keyboard (only if the viewer is opened
as a stand-alone window). The nearest neighboring point may belong to another series if
the trend is showing data from multiple data tables with a different sampling rate.

3D

Switches on/off  the 3-dimensional (3D) display  mode. It  is  possible  to  change  the  3D
depth by specifying a percentage value (as a number or using arrow buttons).

Legend

Shows/hides a legend which displays the time stamp (date and time) corresponding to
the current ruler position and a list of series. For each series, an alias  (or name)  and a
value is displayed. The value corresponds to the current ruler position. The value may be
accurate, approximate or invalid.

An accurate value is the one that corresponds to a series point (actual value read from a
data table). An approximate value is the one calculated from the two neighboring series
points  if  such  values  are  available  within  the  current  page.  An  approximate  value  is
marked with an asterisk (*) in the legend. This situation occurs when the trend shows
data from multiple data tables with a different  sampling  rate.  As  a  result,  points  of  a
series may  have different  time stamps than  points  of  another series.  An  invalid  value
belongs to a series  that  does  not  contain  any  points  within  the  current  page.  Also,  a
series may contain some points within the current page but the ruler position is outside
the points. An invalid value is marked with a question mark (?) in the legend.

Auto-scroll

Switches  on/off  the  auto-scroll  feature,  i.e.  automatically  scrolling  the  trend  view  to
display the latest data.

Show Trend from Specified Date and Time

Shows a dialog for selecting a date and time where the trend view should start.
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Customize Trend

Shows the Customize Trend dialog which allows for customizing all settings affecting the
appearance and behavior of the trend. The changes are automatically saved when closing
the viewer only if a user is logged on to the program.

Settings

Shows a menu for working with the trend's settings. The menu  contains  the  following
commands:

Load Design Settings

Loads the trend's design settings, i.e. the settings defined through the Trend Manager.
This command is useful if  the design  settings  have  changed  since  user settings  were
saved to a user profile (see Saving and loading trend settings below).

Load User Settings

Brings up a dialog with a list  of  all users that  have the trend's settings stored in  their
profile. In addition to  these  users,  the  list  can  include  an  item named  Default  which
corresponds  to  the  trend's  default  settings  (see  Saving  and  loading  trend  settings
below). Upon selecting a user from the list and confirming the dialog, the trend's settings
stored in the selected user's profile are applied.

Save User Settings

Brings up a dialog  with  a  list  of  all  users  to  which  the  trend's  settings  can  be  made
available. In addition to these users, the list  can include an item named Default  which
corresponds  to  the  trend's  default  settings  (see  Saving  and  loading  trend  settings
below). The user is always allowed to save the settings to his/her own profile. If the user
is allowed to edit trends (i.e. use the Trend Manager), he/she can also save the settings
to the Default profile. If the user has the User administrator option active or is assigned
the Servicing right, he/she can save the settings to all user profiles.

Print Trend

Brings up a dialog that  enables the user to set  up various print  options  and  print  the
trend. By default, the trend's background color is not  printed. This is controlled by  the
Print  with  transparent  background  option  which  can  be  configured  through  the
Customize Trend dialog.
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Close

Closes the viewer. If a user is logged on, the trend's settings are automatically  saved to
the user's profile.

2.6.1.1  Saving and Loading Trend Settings

When the viewer is closed, all the trend's settings  are  automatically  saved  to  the  currently
logged-on user's profile; if no user is logged on, the settings are not  saved. The settings can
also be saved by choosing the Save User Settings command from the Settings button's menu.

Before a trend is displayed in the viewer, the trend's design settings (i.e. the settings defined
through  the  Trend  Manager)  are  applied  first.  If  a  user is  logged  on  that  has  the  trend's
settings stored in his/her profile (i.e. if the file containing the settings exists), the settings are
applied  (overriding  the  design  settings).  Otherwise,  the  program  searches  for  the  trend's
settings in the Default profile (in the folder <Project> \ Settings \ Profiles \
Default \ DbTrends \ Trends). If the settings are found they are applied (overriding
the design settings).

The settings for the trend can also be loaded from the profile of any user that already has his/
her own settings of the trend (see the Load User Settings command from the Settings button's
menu).

If  a  user already  has  his/her own  settings  of  a  trend  and  the  trend's  design  settings  are
changed (e.g. background color), the changes will not take effect when the trend is displayed
by  the user. To  apply  the  changes,  the  Load  Design  Settings  command  from the  Settings
button's menu must be invoked.
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2.7  Reports

Reports (sometimes called historical reports) are used to view historical data. Historical data is
the  data  of  tags  stored  (along  with  a  time  stamp)  in  data  tables  (databases).  Every  user
defined in a project can have his/her own settings of reports. Reports can be displayed with a
tool called report viewer.

Reports  can  be  defined  through  a  tool  called  Report  Manager  (defined  reports).  A  list  of
available defined reports can be accessed via the > File > Reports command.

Reliance 4 – Report viewer

Report viewer

Report Manager
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2.7.1  Report Viewer

The report viewer is a tool designed for displaying historical data in a tabular format.

The viewer can be opened as a stand-alone window  or a window  embedded into the  main
window  of  the runtime software. The way  of  opening the viewer is  controlled  by  the  Insert
report window into main window option in the list of available reports. If the option is active,
the viewer gets embedded into the main window  in the way  allowing the user to move the
viewer window and change its size. In this case, the viewer behaves as a sizeable stay-on-top
visualization window with a title bar. This way, it  is possible to view  multiple reports at  the
same  time.  If  the  Insert  report  window  into  main  window  option  is  not  active,  the  viewer
window  opens maximized and covers up  (obscures)  the  main  window.  The  viewer window
opened this way cannot be moved and resized. Therefore, the viewer must  be closed before
the user can continue to work with other parts of the application.

The top part of the viewer contains a toolbar for working with the report. The actual report  is
displayed in the area below the toolbar.

The toolbar contains the following commands:

Customize Report

Shows the Customize Report  dialog which allows for customizing  various  settings,  e.g.
settings affecting report  columns (visibility, width, summary  calculations),  report  footer
and printing. The changes are automatically saved when closing the viewer only if a user
is logged on to the program. For more information, see the chapter Customize a report.

Set Filter

Enables the user to define and apply a filter for the data to be displayed. The report only
shows the data table records meeting the filter conditions. For detailed information, see
the chapter Report filter.

Cancel Filter

Cancels the apllied filter. The report shows all records from the data table.

Open File

Enables the user to select and open an archive file. The report shows the data contained
in the file instead of the previously displayed data.
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Export Report

Saves the data displayed in the report to a text file. For more information, see the chapter
 Export.

Print Report

Prints the displayed report.

Page Setup

Brings up a dialog for configuring various settings, such  as  page  size,  orientation  and
margins, to be used when printing the report.

Show Preview

Shows a print  preview  of  the report. The preview  enables the user to browse pages by
using the toolbar commands available in the top part of the preview window. The toolbar
also contains commands for printing and exporting the report into various file formats (e.
g. PDF, XLS, HTML, RRP).

Settings

Shows a menu for working with the report's settings. The menu contains the following
commands:

Load Design Settings

Loads the report's design settings, i.e. the settings defined through the Report Manager.
This command is useful if  the design  settings  have  changed  since  user settings  were
saved to a user profile (see Saving and loading report settings below).

Load User Settings

Brings up a dialog with a list  of  all users that  have the report's settings stored in their
profile. In addition to  these  users,  the  list  can  include  an  item named  Default  which
corresponds  to  the  report's  default  settings  (see  Saving  and  loading  report  settings
below). Upon selecting a user from the list and confirming the dialog, the report's settings
stored in the selected user's profile are applied.
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Save User Settings

Brings up a dialog with a list  of  all  users  to  which  the  report's  settings  can  be  made
available. In addition to these users, the list  can include an item named Default  which
corresponds  to  the  report's  default  settings  (see  Saving  and  loading  report  settings
below). The user is always allowed to save the settings to his/her own profile. If the user
is allowed to edit reports (i.e. use the Report Manager), he/she can also save the settings
to the Default profile. If the user has the User administrator option active or is assigned
the Servicing right, he/she can save the settings to all user profiles.

Summary Calculation Results

Brings up a window showing the results of summary calculations (minimum, maximum,
sum or arithmetic average). The summary calculations feature can be turned on/off  for
individual  report  items  (columns)  through  the  Customize  Report  dialog.  If  summary
calculations are not active for any column, the command is disabled.

Close

Closes the viewer. If a user is logged on, the report's settings are automatically  saved to
the user's profile.

2.7.1.1  Customizing a Report

Columns

The left  part  of  the this contains a list  of  report  items (columns). The right  part  of  the
page enables you to view/modify the selected column's properties.

Visible

Determines whether to show the column in the report. It allows for temporarily hiding the
column. By default, this option is active.

Width

Determines the column's width in pixels.

Summary calculations

Turns on/off the summary  calculations feature for the column. The results of  summary
calculations can be displayed through the Summary Calculation Results command. If the
report is printed, the results are printed at the end of the report in the respective column.
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Report footer

This page contains an edit box that lets you specify the text to be displayed in the report
footer.

Font

Brings up a font selection dialog. The selected font will be used for the text displayed in
the report footer.

Print

This page lets you configure report print options.

Print on white background

If  this option is active, all columns and other parts of  the  report  (Report  title,  Column
header, Page footer)  will be printed with a transparent  background regardless  of  their
color settings.

2.7.1.2  Report Filter

To configure and apply  a filter for the report  displayed in the viewer,  choose  the  Set  Filter
command from the toolbar. This brings up a dialog that  enables you to select  report  items
(columns) to be filtered. After confirming this dialog, the Filter Settings  dialog appears which
lets you configure filter conditions for individual columns and the relationship between the
conditions.

Relationship between columns filter conditions

If the Concurrent meeting all conditions option is active, a record will only be displayed if
all conditions are met (logical conjunction). If the Meeting at least one condition option is
active,  a  record  will  only  be  displayed  if  at  least  one  condition  is  satisfied  (logical
disjunction).

Column name

Specifies the name of the column for which a condition is being defined.

Range limits

Specifies the limits of the range (Minimum, Maximum).
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Value position

Specifies the position of values meeting the condition (Inside range, Outside range).

Include range limits

Determines if values equal to the limits meet the condition.

2.7.1.3  Saving and Loading Report Settings

When the viewer is closed, all the report's settings are automatically  saved to  the  currently
logged-on user's profile; if no user is logged on, the settings are not  saved. The settings can
also be saved by choosing the Save User Settings command from the Settings button's menu.

Before a report is displayed in the viewer, the report's design settings (i.e. the settings defined
through the Report Manager)  are applied first. If  a user is  logged  on  that  has  the  report's
settings stored in his/her profile (i.e. if the file containing the settings exists), the settings are
applied  (overriding  the  design  settings).  Otherwise,  the  program  searches  for  the  report's
settings in the Default profile (in the folder <Project> \ Settings \ Profiles \
Default  \  DbReports  \  Reports).  If  the  settings  are  found  they  are  applied
(overriding the design settings).

The settings for the report can also be loaded from the profile of any user that already has his/
her own  settings  of  the  report  (see  the  Load  User  Settings  command  from  the  Settings
button's menu).

If  a user already  has his/her own  settings  of  a  report  and  the  report's  design  settings  are
changed (e.g. column width), the changes will not take effect when the report is displayed by
the user. To apply the changes, the Load Design Settings command from the Settings button's
menu must be invoked.
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2.8  Custom Reports

Custom reports are used to represent real-time or/and historical data in a customized layout.
A custom report can contain additional text and graphical objects (e.g. pictures). The layout of
a  custom report  is  defined  by  a  template.  A  template  is  a  document  (file)  in  one  of  the
following  formats:  *.txt  –  a  text  file,  *.html  –  an  HTML  page,  or  *.rrp.  –  a
FastReport template. A template contains special markers (so-called tags) that are be replaced
with  real-time  data  (from  a  visualization  project)  when  the  custom  report  is  generated.
Templates can be edited even at  runtime to meet  user requirements.  Templates  in  text  or
HTML format can be changed using a text editor. Templates in FastReport format  (*.rrp) can
be changed through a program called Custom Report  Designer (program R_FRDesigner.exe
located in <Reliance4>\Utils folder).

A list of available custom reports can be accessed via the  > File > Custom Reports command.

The custom report selected from the list is displayed in a tool called custom report viewer and
can be printed or exported to various file formats.

Reliance 4 - Custom report preview

If the custom report is based on a template in text or HTML format, it is possible to save it to a
*.txt, *.html or *.mht file.
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If the custom report is based on a FastReport template, it is possible to save it to a *.rrp  file
which  can  later  be  viewed  and/or  printed  with  a  program  called  Custom  Report  Viewer
(program R_FRViewer.exe located in <Reliance4>\Utils  folder). The custom report  can
also be exported to PDF or HTML format and saved in a user defined folder or sent via e-mail.
It is recommended to use PDF format.
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2.9  Recipes

A recipe is a group of tags from one or more devices. The values of these tags can be saved to
a  file.  Later,  the  values  can  be  loaded  from  the  file  and  transferred  (written)  into  the
respective devices. Recipes (groups of tags) can be defined in the development environment.
In the runtime software, it is only possible to save and load the data of these group of tags.

The  dialog  window  for  managing  the  recipes  can  be  displayed  via  the  > File  > Recipes
command.  The  left  part  of  the  window  contains  a  list  of  recipe  folders  defined  in  the
development environment. The middle part of the window contains recipes contained in the
selected folder. The right part of the window contains a list of stored data files for the selected
recipe. In the development environment, it is possible to define the access rights required for
different  operations  with  a  recipe,  such  as  loading  the  recipe  to  the  device(s),  saving  the
recipe to a file or deleting the recipe's data file.

Reliance 4 – Recipes

The following commands are available:
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Load into devices

Transfers (writes)  the  data  of  the  selected  recipe  from the  selected  data  file  into  the
respective device(s).

Save

Saves the tag values of the selected recipe to a data file. The recipe data files are stored
in  the  <Project>  \  Settings  \  Recipes  folder,  and  have  an  *.rdt
extension.

Rename

Enables the user to change the name of the selected recipe data file.

Delete

Deletes the selected recipe data file.
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2.10  Postmort Record Player

Postmort  is  the  unique  feature  designed  for  recording  and  replaying  the  operation  of  a
monitored processes. In a simplified manner, it  can be compared to a video recorder (VCR).
The process's visualization can later be  replayed  from a  selected  time  in  the  past  using  a
selected (real-time or higher) speed. You can pause the replaying at any moment and navigate
forward through the process record by record (each record represents a change in the process
data) or continue the replaying using the same or different speed. This can be useful in case
of an accident or process failure to find and analyze the cause of the problem.

Reliance 4 – Postmort

Most functions of the runtime software are stopped while replaying the process (e.g. reading
real-time data of devices from communication drivers or data servers, logging historical data to
data  tables,  executing  scripts  or  processing  recipes).  Postmort  recording  is  stopped,  too.
Therefore, in most applications one computer is usually designed for the playback of postmort
records (recorded by other computer).

If  postmort  recording is active,  the  complete  data  of  all  connected  devices  is  stored  when
recording starts and then every minute. Within each minute, only changes in data are stored
to minimize the size of  data  files.  This  also  ensures  that  all  changes  (even  fast  ones)  are
recorded. The length (number of days) of recorded history  is defined in the project  and it  is
limited only by disk space.

Postmort Record Player is accessible through the > File > Postmort Record Player command.

Postmort Record Player contains the following commands and parameters:
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Play

Starts replaying the process from the selected time stamp (selected in the Replay  start
time combo box).

Pause

Pauses replaying the process. Afterwards, the process can be replayed record by  record
(change by change) or the replaying can be continued.

Stop

Stops replaying the process. The time stamp selected in the Replay start time combo box
is not changed.

Step

Loads the data of the next record (next change).

Close

Closes the player and restores the data in the visualization.

Replay start time

Enables the user to select the time stamp from which the replay should start. The combo
box contains a list of all available time stamps (the complete data is available for these
time stamps).

Replay speed

Specifies the replay  speed. The user can select  the Normal  speed (real-time) or higher
speed (at most 50 times higher).

Status

Indicates  the  current  state  of  the  player.  The  possible  states  are:  Ready  to  replay,
Replaying, Replaying paused.

Record date

Displays the date of replayed data (the date when the data was recorded.).

Record time

Displays the time of replayed data (the time when the data was recorded.).
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2.11  Managers

Managers  are  tools  designed  to  view,  create  and  configure  objects  that  are  part  of  a
visualization project. All managers available in the runtime software have a similar layout:

Toolbar

Contains commands for working with objects. Most of  the commands in the toolbar are
common to all managers (see the chapter Common Toolbar Commands).

Top left pane

The top left pane displays the objects in a hierarchical tree diagram in order to show the
subordination of one object to another. 

Bottom left pane

The bottom left pane displays the objects on a list. These are the objects subordinated to
the object selected in the top left  pane. The list  allows you to select  and edit  multiple
objects at a time. When you select an object on the list, the manager displays the object's
properties in the right  pane.  If  multiple  objects  are  selected  on  the  list,  the  manager
displays the properties of the selected object that has the input focus or the first object in
the selection (if no object in the selection is focused).

Right pane

The right pane displays properties of the object(s) selected in the top left or bottom left
pane.  The  properties  can  be  edited  as  needed.  When  you  edit  a  property,  the
corresponding control changes its color to yellow. This status is also indicated by a yellow
exclamation mark displayed beside the edited object(s)  in the top left  and bottom left
pane.  When  the  selection  is  about  to  change,  the  manager  checks  all  the  edited
properties to see if they are correct. If  so, the manager assigns the edited properties to
the  selected  object(s)  and  the  yellow  exclamation  mark  changes  its  color  to  blue.
Otherwise,  the  selection  remains  unchanged.  If  the  edits  have  been  assigned  to  the
selected  object(s),  they  can  later  be  saved  to  the  appropriate  files  by  the  Save  All
command or canceled  by  invoking  the  Close  command  and  choosing  not  to  save  the
changes.  Naturally,  you  can  also  edit  a  property  and  use  the  Save  All  command
immediately. The manager checks all the edited properties to see if they are correct. If so,
the manager assigns the edited properties to the selected object(s) and saves the object
(s) to the appropriate files.

In the runtime software, objects can be configured/viewed through the following managers:

Trend Manager
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Report Manager

User Manager

Project Manager

2.11.1  Common Object Properties

Name

A name of the object that must be unique within the project or the parent object (e.g., a
tag name within a device); it is case-insensitive.

Alias

An  optional  alternative  name  of  the  object  usually  used  in  the  GUI  during  runtime.
Therefore,  it  should  be  descriptive  and  understandable  to  the  user.  In  multilanguage
projects, an alias can be localized (i.e., translated into all project languages), which is in
contrast to a Name.

Comment

An  optional  comment  about  the  object  used  by  the  visualization  project  developer
(systems  integrator).  It  can  be  useful  when  configuring,  debugging,  and  altering  an
application.

Description

An  optional  description  of  the  object  intended  for  the  end  user.  In  multilanguage
projects, a description can be localized (i.e., translated into all project languages), which
is in contrast to a Comment.

External ID

The object's identifier suitable when exchanging data with third-party  systems that  use
their own ID.

2.11.2  Common Toolbar Commands

 New Folder (Alt+Ins)

Is used to create a new folder. The type of the newly created folder depends on the object
selected when invoking the command.
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 View

Is used  to  change  the  view  style  of  the  objects  listed  in  the  bottom left  pane  of  the
manager. The Picture Manager allows for displaying pictures as thumbnails.

 Sort

Is used to sort the objects directly subordinated to the object selected in the tree diagram
by the selected column of the bottom left pane.

 One Level Up (BkSp)

Is used to move the selection one level up in the tree diagram. 

� Quick Filter (Ctrl+F)

Allows you to quickly  search for an object  by  name. The Match Beginning  of  String  
command is used when searching for objects whose names start with the specified text
and the Match Any Part of String  command when searching for objects whose names
contain the specified text. The Close  command closes the quick filter.

 Find Object (Ctrl+Shift+F)

Is used to bring up the Find Obj ect  dialog box  to search for an object  by  its name. To
speed up searching the object, specify the type of the object  to be searched and select
the  Subtree  of  selected  obj ect  only  option.  Also,  the  Whole  strings  only  and  Case
sensitive options are available. The search results are displayed in a separate window;
select (mark) the found object in the respective manager by double-clicking it.

 Options

Is used to bring up the Options dialog box to view or configure the settings related to the
manager (e.g., to Alphabetically sort obj ect in the tree). On the Link replacement page of
the dialog, you can configure the options used while duplicating objects in the manager.
The manager can replace links to tags (when duplicating data tables, real-time trends,
custom reports, and recipes) and links to data table fields (when duplicating trends and
reports). In addition, the Options dialog of the Trend Manager enables you to configure
the  options  related  to  adopting  user  settings  of  trends  when  the  Adopt  trend  user
settings property is used.



54 Managers

Reliance 4 – Runtime Software

 Undo (Ctrl+Z)

Is used to cancel  the  edits  that  have  not  yet  been  assigned  to  the  selected  object(s)
(yellow background).

 Copy (Ctrl+C)

Is used to copy the currently selected object(s) to the clipboard.

 Cut (Ctrl+X)

Is used to delete the currently  selected object(s)  from the structure and place it  to the
clipboard.

 Paste (Ctrl+V)

Is used to paste the contents of  the  clipboard  into  the  structure.  The  contents  of  the
clipboard remain unchanged.

 Duplicate (Ctrl+D)

Is used to duplicate the currently selected object(s). The contents of the clipboard remain
unchanged.

 Delete (Del)

Is used to delete the currently selected object(s) from the structure.
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2.11.2.1  Replacement of Links to Tags

Replace links when duplicating an object

Determines whether to replace the links to tags when an object  is duplicated based on
the same tag name in the source and the target device. 

Remove the original link if a tag with the same name does not exist in the target device

Determines whether to remove the original link when the target device doesn't contain a
tag with the same name.

2.11.2.2  Replacement of Links to Data Table Fields

Replace links when duplicating an object

Determines whether to replace the links to data table fields when an object is duplicated
based on the same field name in the source and the target data table. 

Remove the original link if a field with the same name does not exist in the target data
table

Determines  whether  to  remove  the  original  link  when  the  target  data  table  doesn't
contain a field with the same name.
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2.11.3  Trend Manager

The Trend Manager allows you to define and configure trends. In the context of  Reliance, a
trend is an object used for the graphic presentation of the data stored in a data table(s) (i.e.,
historical data). Trends can be displayed at runtime via the trend viewer.

Reliance 4 – Trend Manager

The  Trend  Manager  window  has  the  same  layout  as  other  managers  (see  the  chapter
Managers). In addition to the common toolbar commands, the toolbar contains the New Trend
 , New Trend Series , New Chart Axis , and Add Trend Series  commands.

The options of the Trend Manager at runtime and design-time are identical. After a new trend
is added, you have to select the computer(s) to which the trend should be connected.

Trend Properties
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Trend Series Properties

Trend Axis Properties

2.11.3.1  Trend Properties

Common Object Properties
Title

Specifies the text to be displayed as the title of the trend using the specified font. If the
Use trend alias  or name option is  active,  the  trend's  alias  (or name  if  an  alias  is  not
specified) is used as the title.

Text

Specifies the Font of the title.

Background

Specifies the background Color of the trend.The color should contrast with colors used for
individual series.

Ruler/Cross

Specifies the Color and Width  of  the ruler/cross. It  is a  tool  designed  for the  accurate
reading of  values of  individual  series  at  the  crossing  point  of  the  ruler/cross  and  the
series. The color of the ruler/cross should contrast with the background color. The width
is specified in pixels.

Paging

Determines the time range displayed on a single page of  the trend. If  the Point  count
option is active, the  trend  viewer always  attempts  to  display  the  specified  number of
series points on a single page, which represents the number of records stored in the data
table (i.e., the Point count property is independent of the number of trend series). In this
case, it is required that all the series be linked to the same data table so that each series
displays points with the same time stamps. If the Time range option is active, the trend
viewer  always  displays  the  specified  time  range  on  a  single  page  regardless  of  the
amount of series points.
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Axes

Vertical axis

Title

Allows you to specify the title of the trend's vertical axis.

Hidden

If this option is active, the actual axis will not be displayed, but its setting will be used.

Scale

The Automatic property determines whether the axis automatically adjusts its minimum
and/or maximum to the series' values within the current time range. If the axis' minimum
and/or maximum are  not  automatic,  they  must  be  specified  as  the  Minimum  and/or
Maximum properties.

Position relative to chart

Start (%)

Positions the axis' maximum with respect to the original position.

End (%)

Positions the axis' minimum with respect to the original position.

Horizontal position (%)

Positions the axis with respect to the beginning of the chart.

Series vertical axes

Position automatically

Determines  whether  the  position  of  the  vertical  axes  is  generated  automatically  or
according  to  the  position  defined  for  the  series'  vertical  axes.  The  axes  can  be
automatically positioned either Side by side or Above each other.

Series

Contains the list of trend series. You are enabled to change the order of the series using
the arrows above the list. The specified order will take effect, for example, in the trend's
legend.
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2.11.3.2  Trend Series Properties

Common Object Properties
The name of a series can be synchronized with a data table field name.

Data table field

Specifies the link to the data table field whose values (time samples) are to be displayed
by  the series. If  the Paging  property  is set  to Time  range,  the  series  can  be  linked  to
different data table fields, i.e., the trend can display data stored in different data tables.

Series

Specifies the series' Color. It should contrast with the background color of the trend. The
series' Line width can also be specified.

Chart type

Determines how to graphically represent the series' values. The series can be displayed
as a Line chart, Bar chart, or Area chart.

Axes

Vertical axis

Specifies the series' vertical axis. The series can use the trend's vertical axis (the Trend
chart  axis  option),  the  predefined  axis  (the  Selected  axis  option),  or  a  vertical  axis
intended only for this series (the Custom axis option – this option is suitable if the series'
value range is completely different from that of the other series).

Title

Allows you to specify the title of the series' vertical axis. If  the Use series alias  or name
option is active, the series' alias (or name if an alias is not specified) is used as the title.

Hidden

If this option is active, the actual axis will not be displayed, but its setting will be used.

Scale



60 Managers

Reliance 4 – Runtime Software

The Automatic property determines whether the axis automatically adjusts its minimum
and/or maximum to the series' values within the current time range. If the axis' minimum
and/or maximum are  not  automatic,  they  must  be  specified  as  the  Minimum  and/or
Maximum properties.

Position relative to chart

Start (%)

Positions the axis' maximum with respect to the original position.

End (%)

Positions the axis' minimum with respect to the original position.

Horizontal position (%)

Positions the axis with respect to the beginning of the chart.

2.11.3.3  Trend Axis Properties

Common Object Properties
Axis

Title

Allows you to specify the title of the trend's axis. If the Use axis alias or name option is
active, the axis' alias (or name if an alias is not specified) is used as the title.

Hidden

If this option is active, the actual axis will not be displayed, but its setting will be used.

Scale

The Automatic property determines whether the axis automatically adjusts its minimum
and/or maximum to the series' values within the current time range. If the axis' minimum
and/or maximum are  not  automatic,  they  must  be  specified  as  the  Minimum  and/or
Maximum properties.

Position relative to chart

Start (%)

Positions the axis' maximum with respect to the original position.
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End (%)

Positions the axis' minimum with respect to the original position.

Horizontal position (%)

Positions the axis with respect to the beginning of the chart.
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2.11.4  Report Manager

The Report Manager allows you to define and configure reports. In the context of Reliance, a
report is an object used for the graphic presentation of  the data stored in a data table (i.e.,
historical data) in a tabular format. Reports can be displayed, printed, exported, and sent  by
e-mail at runtime via the report viewer.

Reliance 4 – Report Manager
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The  Report  Manager  window  has  the  same  layout  as  other  managers  –  see  the  chapter
Managers. In addition to the common toolbar commands, the toolbar contains the New Report
 , New Report Item , and Add Report Items  commands. The last mentioned command
brings up a dialog window for the selection of field(s) of a data table. New fields are added to
the selected report after one or more data table fields are selected (Shift + left mouse button
allows for the selection of  multiple fields in a row,  Ctrl  + left  mouse  button  allows  for the
selection of fields one by one).

The options of  the  Report  Manager  at  runtime  and  design-time  are  identical.  After a  new
report is added, you have to select the computer(s) to which the report should be connected.

Report Properties

Report Actions

Report Title

Report Column Header

Report Page Footer

For data table fields, the following settings can be edited:

Report Item Properties

Report Item Title

2.11.4.1  Report Properties

Common Object Properties

Data table

Specifies the link to the data table whose contents are to be displayed by the report.

Report elements

Determines which elements to include in the report: Title, Column header, Page footer.

Grid

Determines whether to display grid lines in the background. The Horizontal and Vertical
lines can be displayed independently.
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Row height

Specifies the height (in pixels) of a single row of the report. It may affect the number of
rows displayed on a single page of the report.

Column order

Contains a list of the specified report items. To change the order of a column, change the
respective item's position on the list by using the arrow buttons in the toolbar above the
list.

Navigation

Day start

Allows you to specify the day start using hour and minute values.

Selected record

Write time stamp to tag

Allows storing the selected record's time in a tag. The record was carried out by the user
in the active report viewer at runtime.

Convert to local time

Determines whether to convert the selected record's time stamp to the operating system's
time.

2.11.4.2  Report Actions

Action list

Specifies the list of actions that can be executed from the report viewer.

2.11.4.3  Report Title

Specifies the title printed on the first report page. The title is printed only if it  is enabled on
the report properties' Basic page (the Title option must be active).

Use report alias or name

Determines whether to use the report's alias (or name if an alias is not specified) as the
title. If this option is deactivated, any title can be entered.
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Text

Specifies the Font of the title.

Background

Specifies the background Color of the title. The color should contrast with the text color.

Frame

Determines whether to frame the report  header with a  line  of  the  specified  Color  and
Width (in pixels).

Bar height

Specifies the height (in pixels) of the report header bar. The height should correspond to
the size of the title's font.

Alignment

Specifies the alignment of the title within the report header.

Preview

Displays the report title's preview.

2.11.4.4  Report Column Header

Specifies the text printed on top of  every  page of  the report. The text  is printed only  if  it  is
enabled on the report properties' Basic page (the Column header option must be active).

Frame

Determines whether to frame the column header with a line of  the specified Color and
Width (in pixels).

Height

Specifies the height (in pixels) of the column header.

Preview

Displays the report column header's preview.
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2.11.4.5  Report Page Footer

Specifies the text printed on the bottom part of every report page. The text is printed only if it
is enabled on the report properties' Basic page (the Page footer option must be active).

Text on footer

Determines whether to display the specified text  on the footer using the specified Font
and Alignment.

Page numbers

Determines whether to display the page number on the footer using the specified Font
and Alignment.

Page numbers and text on separate rows

Determines whether to print the page number and the footer text on separate rows. If this
option is not active, the footer is printed on a single line.

Background

Specifies the background Color of the footer. The color should contrast with the text color
and the page number color.

Height

Specifies the height (in pixels) of the footer. The height should correspond to the size of
the fonts.

Preview

Displays the report footer's preview.

2.11.4.6  Report Item Properties

Common Object Properties
The Name of an item can be synchronized with a data table field name.

Data source

Specifies the link to a data source. The data source can be a Data table field or Date or
time of a data table record. For the most part, the first two report items are linked to date
and time, the other report items are linked to data table fields.
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Text

Specifies the Font of the item’s text. The size of the font should correspond to the report's
row height.

Background

Specifies the background Color of the item's text. The color should contrast with the text
color.

Column width

Specifies the width (in pixels) of the item's column.

Value format

Specifies the format string to be used when converting the item's value to text for display
purposes. It is only used for the report items linked to numeric data table fields.   

Alignment

Specifies the alignment of the item’s text within the item's column.

Preview

Shows how the value of the report's records will be displayed.

2.11.4.7  Report Item Title

Use item alias or name

Determines whether to use the item's alias (or name if  an alias is not  specified) as the
column title. If this option is deactivated, any title can be entered.

Text

Specifies the Font of the item's column title.

Word wrap

Determines whether to wrap the column title's text.

Background

Specifies the background Color of the item's column title. The color should contrast with
the text color.



68 Managers

Reliance 4 – Runtime Software

Alignment

Specifies the alignment of the item's column title within the column.

Preview

Displays the report item title's preview.

2.11.5  User Manager

The User Manager  allows you to define and configure users. In the context  of  Reliance, a
user is an object representing an end user (usually operator) allowed to log on to the program.

Reliance 4 – User Manager
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The User Manager window has the same layout as other managers (see the chapter Managers
).  In  addition  to  the  common  toolbar  commands,  the  toolbar  contains  the  New  User  
command.

The options of the User Manager at runtime and design-time are identical. After a new user is
added, you have to select the computer(s) to which the trend should be connected.

Common Object Properties

User Properties

User Access Rights

Access Restrictions

2.11.5.1  Basic

Note: The name is entered by the user when logging on to the program.

Identification

Authentication

Specifies  the  user's  authentication  method.  To  verify  the  user’s  identity,  you  can  use
either project-defined data (the Reliance option) or Windows data (the Windows option). 

Password

Specifies the password that is entered by the user when logging on to the program. It is
case-sensitive.

Confirm password

Must have the same value as the Password property.

Domain

Specifies the Windows user's domain.

Windows user

Specifies the user's name used for his/her identification in Windows.
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Code

Specifies the code assigned to the user if logging on by a hardware code sensor is used.
Otherwise, the value is ignored. For more information,  see  the  chapter Logging  on/ off
using a hardware code reader in the Runtime Software manual.

Contact

A Phone number and E-mail can be specified.

Miscellaneous

Allow user to log on

Determines whether the user’s account  is active. It  allows you to temporarily  enable or
disable the user to log on to the program.

Log user log-on

Determines whether to log the information about logging the user on to the program to
the alarm/event database.

Log user log-off

Determines whether to log the information about logging the user off  of  the program to
the alarm/event database.

User administrator

Determines whether to allow  the user to administer users at  runtime. If  the property  is
active,  the  user can  add  new  users  and  modify  or delete  existing  users  via  the  User
Manager.

Language

Program language

Allows you to specify the language of the GUI, which is to be set  after the user logs on
(labels in menus, toolbars, etc.).

Proj ect language

Allows you to specify the language of project-defined text strings, which is to be set after
the user logs on (labels of components in visualization windows, alarm/event text strings,
etc.).
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2.11.5.2  Access Rights

These properties specify the user's access rights to the program. For example, if  the Control
process right is required for switching on a pump by a Button component, it can only be done
by a user(s) who has been assigned this access right.

Servicing right

Determines  whether  the  user  has  a  special  right  that  ensures  the  user  cannot  be
modified or deleted at runtime via the User Manager by a user administrator that has not
been assigned the Servicing right. This right can only be activated through this property
in the development  environment. This feature enables Reliance  systems integrators to
secure certain parts of the application from other users.

Check All

Is used to select all the rights on the list.

Uncheck All

Is used to unselect all the rights on the list.

Edit...

Is used to bring up the Proj ect Options dialog box  to rename the rights. This command
can only be executed at design-time.

2.11.5.3  Restrictions

These  properties  determine  the  access  restrictions  applied  when  the  user  logs  on  to  the
program. After logging the user off of the program, the default restrictions configured for the
computer are restored.

Disable 'Start' menu

Determines whether to disable using the Windows Start menu.

Hide task bar

Determines whether to hide the Windows task bar.

Hide icons on desktop

Determines whether to hide icons on the Windows desktop.
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Disable minimizing main window

Determines whether to disable minimizing the main window of the runtime software.

Disable moving main window

Determines whether to disable moving the main window of the runtime software.

Disable resizing main window

Determines whether to disable resizing the main window of the runtime software.

Disable closing main window

Determines whether to disable closing the main window  of  the runtime software using
the Close command from the system menu and the corresponding icon on the title bar.
This options does not affect the File > Exit command.

Disable printing alarms/ events, trends, reports...

Determines whether to disable printing alarms/events, trends, and reports at runtime.

Disable customizing trends

Determines  whether to  disable  the  commands  for  changing,  loading,  and  saving  the
settings in the trend viewer at runtime.

Disable customizing reports

Determines  whether to  disable  the  commands  for  changing,  loading,  and  saving  the
settings in the report viewer at runtime.

Disable Trend Manager

Determines whether to disable the Trend Manager command at runtime.

Disable Report Manager

Determines whether to disable the Report Manager command at runtime.

Disable Proj ect Manager

Determines whether to disable the Proj ect Manager command at runtime.

Disable entering tag values in Proj ect Manager

To be added.
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Disable Postmort Record Player

Determines whether to disable the Postmort Record Player command at runtime.

2.11.5.4  Alarms/Events

Alarm/event notifications

Notify via E-mail

Determines whether to notify the user of alarms/events via an email message.

Notify via SMS

Determines whether to notify the user of alarms/events via a text message.

Alarm/event groups

Enumerates the groups of alarms/events that the user should be notified of. The user will
be  notified  of  an  alarm/event  only  if  the  enumeration  of  the  groups  selected  for the
alarm/event is a subset of the enumeration of the groups selected for the user.

Example 1:

An alarm belongs to groups A, B. 

The user belongs to groups A, B, C. 

The user will be notified of the alarm.

Example 2:

An alarm belongs to groups A, B, C.

The user belongs to groups A, B.

The user will not be notified of the alarm.

2.11.6  Project Manager

The Project Manager is a tool designed to display information about objects defined in the
visualization  project  (devices,  tags,  alarms/events,  data  tables,  trends,  etc.).  Objects  not
connected to the computer on which the project  is  running  may  not  be  listed.  Diagnostics
information  is  available  for some  object  types  (the  value  and  quality  of  a  tag,  send  and
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received packets via a communication channel, etc.).

The  Proj ect  Manager  window  is  divided  into  four basic  areas  (the  toolbar,  top  left  pane,
bottom left pane and the right pane).

Toolbar

In addition to the View, Sort, One Level Up, Find Obj ects and Options commands (see the
chapter Common  toolbar commands),  the  toolbar contains  the  Start  Diagnostics  and
Stop  Diagnostics  commands.  These  two  commands  activate/deactivate  refreshing
diagnostics information.

Top left pane

Displays the objects defined in the project in a hierarchical tree diagram in order to show
the subordination of one object to another (see the chapter Managers). The objects are
divided into folders named based on the managers in which they were defined. The root
folder (named  based  on  the  project)  contains  the  following  folders:  Data  Structures,
Devices,  Communication  Drivers,  Recipes,  Data  Tables,  Trends,  Real-Time  Trends,
Reports, Custom Reports, Pictures, Actions, Users  and  Control  Areas.  The  most  useful
information is usually contained in the Devices folder (devices, tags, alarms/events) and
in the Control Areas folder (computers, connected devices, communication channels).

Bottom left pane

Displays a list of objects subordinated to the object selected in the top left pane (in the
tree). The displayed objects are on the same level of hierarchy (of the tree structure).

Right pane

Displays properties of the object(s) selected in the tree (top left  pane) or in the bottom
left  pane.  During  runtime,  all  properties  are  read-only  (for  detailed  description  of  all
properties, see the Reliance 4 Development Environment manual.

Object  properties  are  organized  into  pages  in  the  same  way  as  in  the  respective
managers. In addition, the Diagnostics  page showing runtime information is  displayed
for some object types (tags, communication channels).

When a  tag  is  selected,  the  Diagnostics  page  shows  the  following  information:  Value
(value of the tag), Quality (determines whether the tag value is valid or invalid) and Time
stamp (determines the time of the last update of the tag value).

When  a  communication  channel  is  selected,  the  Diagnostics  page  shows  a  dump  of
communication packets. For each packet, the dump includes the following information:
Device, Packet type, Packet length and Send/ Receipt time.
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2.12  Selecting a Language

Even when a project  is running, the user can change the program and project  language by
choosing by the Program Language and Proj ect Language commands from the main menu.

Program Language

Enables the user to select  the language  of  the  GUI (menus,  toolbars,  managers,  etc.).
Currently,  the  following  languages  are  available:  Czech,  English,  Polish,  Russian  and
German.

Reliance 4 – Program Language      Reliance 4 – Project Language

Project Language

Enables  the  user  to  select  the  language  of  the  running  visualization  project  (e.g.
component  labels in visualization windows, alarm/event  texts, texts in  custom reports,
etc.). The languages to be available at runtime are defined in the project.



76 Virtual Keyboard

Reliance 4 – Runtime Software

2.13  Virtual Keyboard

Virtual  keyboard  is  a  dialog  window  that  contains  keys  in  a  similar layout  as  a  common
computer keyboard. The virtual keyboard is usually used in visualization projects running on
computers without a physical keyboard (such as touch panels).

If the virtual keyboard is enabled in the project, it is possible to activate it from the toolbar or
from the menu by the > File > Virtual Keyboard command. In these cases full 104 keyboard is
displayed.

Dialog windows that  require input  contain command which brings up the  virtual  keyboard.
Layout of the virtual keyboard corresponds to the type of data (e.g. if the input of a numerical
value is required only the numerical part of the keyboard is visible). The virtual keyboard can
be configured in such a way that it is displayed every time user input is required.

The virtual keyboard layout corresponds to the current keyboard selected in Windows.

Reliance 4 – Virtual keyboard

Behavior of the following keys on the virtual keyboard differs from a physical keyboard:

Shift

Activates the capital letter mode for the next  typed letter. The Shift  key  on  the  virtual
keyboard  doesn't  have  to  be  pressed  while  typing  a  capital  letter  which  is  the  main
difference from the physical keyboard's Shift key.

NumLock

Displays the numerical keypad on the right side of the virtual keyboard dialog window.

Close

Closes the virtual keyboard window.
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Language

Enables you to change currently selected keyboard in Windows.
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2.14  System Information

The  System  Information  window  provides  information  on  the  runtime  software  and  the
running project. The information is divided into the following pages:

System

Proj ect

The full path and name of the project's main file (file with an .rp4 extension).

Started

Project start date and time.

Computer

The name of the computer on which the project is running.

Event log

Contains a list of messages generated during project startup. The message with a yellow
background may be a sign of a problem, the message with a red background indicates an
error.

Data tables

The red signal light indicates data tables activity (data logging).

Tags

The red signal light indicates updating the tags in the project.

Device communication

The red signal light  indicates  data  communication  between  the  runtime  software  and
device communication drivers.

Scripts

The red signal light indicates that a script is running.

Devices

A list of all devices connected (available) to the computer.
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Data tables

A list of all data tables connected (available) to the computer.

Tags

A  list  of  tags of  all devices connected (available)  to  the  computer.  Full  tag  names  are
displayed (including device name).

DDE sharing

A  list  of  all project  tags shared  via  DDE.  The  Copy  Link  command  (Ctrl  + C)  from the
popup menu copies DDE share name to the clipboard so that  it  can  be  used  in  other
programs (e.g. MS Excel) to view the value.

Network connections

A  list  of  network  connections  with  other  computers  defined  in  the  project.  The  list
contains the following columns:

Remote computer

Project computer name of the remote computer.

Connection type

Information about the type of connection – client or server. Data servers (Reliance Server
and  Reliance  Control  Server)  can  be  both  client  and  server,  Reliance  Control  and
Reliance View can be only a client.

Connection status

Information about the state of a connection.

Last request

Name (type) of the last request to which a reply was sent.

Sent

Number of sent packets.

Received OK

Number of received correct packets.
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Received with errors

Number of received erroneous packets.
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3  Appendix

Running a project

Communication drivers
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3.1  Running a Project

A  visualization project  can run either as a standard application or as a  Windows  service  (if
running in Reliance Server). If a project is to run as a standard application, it can be started in
several ways: from the development environment, through a shortcut to the runtime software
with the required parameters, or from the runtime software by choosing the Run Proj ect or Re-
run  Proj ect  command.  Running  a  project  as  a  Windows  service  (in  Reliance  Server)  is
described in the Data Servers manual.

Running a project from the development environment

A  project  opened  in  the  Reliance 4  Design  development  environment  can  be  run  via
> Proj ect  > Run  command  (F9).  Before  running  a  project  for  the  first  time,  it  is
recommended to check and/or configure the options on the > Proj ect > Options > Runtime
page of the Proj ect Options dialog.

The  Runtime  software  property  specifies  the  program in  which  the  project  should  run
(Reliance  View,  Reliance  Control,  Reliance  Control  Server)  when  started  from  the
development environment.

The  Computer  name  property  specifies  the  computer  (i.e.  logical  computer  defined
through the Proj ect Structure  Manager)  on  which  the  project  should  run  when  started
from the development  environment. The  selected  computer determines  the  settings  (IP
address or hostname, program and project  language, visibility  of  the title bar, menu bar
and  the  toolbar,  etc.)  and  connected  (available)  objects  (devices,  data  tables,  trends,
reports, custom reports, etc.).

Creating a project shortcut from the development environment

A shortcut to the project opened in the Reliance 4 Design  development  environment  can
be  created  via  the  > Proj ect  > Create  Shortcut  command  which  brings  up  the  Create
Shortcut to Proj ect dialog with the following options:

Software

Specifies the software used to open the project (Reliance Design) or to run the project
 (Reliance View, Reliance Control, Reliance Control Server).
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Computer to run project on

Specifies the computer (i.e. logical computer defined through the  Proj ect  Structure
Manager)  on  which  the  project  should  run  when  started  from  the  development
environment.  The  selected  computer  determines  the  settings  (IP  address  or
hostname, program and project language, visibility of the title bar, menu bar and the
toolbar, etc.) and connected (available) objects (devices, data tables, trends, reports,
custom reports, etc.).

Shortcut name

Specifies the shortcut name. By default, it consists of the project name and computer
name in the "Project  name (Computer name)" format. Usually, there is no reason to
change the default value.

Shortcut location

By default, the shortcut  location is set  to the Windows desktop of  the current  user.
Usually, there is no reason to change the default value.

Comment

Optional text describing the shortcut.

To create the specified shortcut, choose the Create command. The dialog is not closed so
that more shortcuts could be created.

Creating a project shortcut manually

A  project  shortcut  can  also  be  created  manually.  First  create  a  shortcut  to  one  of  the
following programs:

Reliance Design (R_Design.exe)

Reliance View (R_View.exe)

Reliance Control (R_Ctl.exe)

Reliance Control Server (R_CtlSrv.exe)

The listed programs are located in the <Reliance4>  directory  (usually  C:\Program
Files\GEOVAP\Reliance4\).

The  next  step  is  to  change  the  shortcut  properties  so  that  the  desired  project  is  run/
opened. Two more parameters have to be added into the Target  edit box which contains
the path and name of  one of  the above programs. The two parameters to be added are
"Project main file path and name" and "Project computer name".
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All the three parameters in the Target edit box must be enclosed in parentheses.

Example:

"C:\Program Files\GEOVAP\Reliance4\R_View.exe" "C:\Reliance4
\Projects\Demo\Demo.rp4" "PC1"

or

"C:\Program Files\GEOVAP\Reliance4\R_Ctl.exe" "D:\Reliance4
\Examples\Demos\BoilerRoom\BoilerRoom.rp4" "Server1"

If the project is to start automatically when a user logs on to Windows, the shortcut must to
be copied  to  the  user's  > Start  > Programs  > Startup  folder (or to  Startup  folder of  All
Users).
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3.2  Communication drivers

In  the  context  of  Reliance,  a  communication  driver  is  a  program  designed  to  provide
communication with a hardware device. If the device is a PLC or other similar I/O device then
the driver provides the transmission of process data from the device to the runtime software
and transmission of commands (e.g. commands for changing process parameters, set-points
or outputs)  from the runtime software to the device. Reliance 4  communication drivers are
DLL libraries located in the <Reliance4>\Drivers  directory. The drivers run as part  of
Reliance Driver Server (R_DrvSrv.exe). This program can run as  a  standard  application
(started  by  the  runtime  software)  or as  a  Windows  service  (in  combination  with  Reliance
Server).
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3.3  Help and Documentation

The  Reliance  system contains  many  help  and  documentation  files.  Most  documents  are
available  in  several  language  translations  and  in  two  different  formats.  The  documents
contained  in  the  <Reliance>\Doc  folder  are  print  friendly  (the  PDF  format).  The
documents contained  in  the  <Reliance>\Help  folder are  usually  displayed  as  context
help in various parts of the Reliance system (CHM files).

First Steps (FirstSteps)

A short tutorial designed for new users of Reliance 4. The user is introduced to the steps
required  to  create  a  simple  visualization  project  in  the  development  environment  –
Reliance 4 Design.

License Activation (LicenseActivation)

A short tutorial that describes how to activate a license for Reliance 4. The activation is
required only if your license is stored in a software key.

Development Environment (Design)

A reference guide for the Reliance 4 Design development environment.

Runtime Software (Runtime)

A  user's  guide  for  the  runtime  software  (Reliance 4  View,  Reliance 4  Control,  and
Reliance 4 Control Server).

Data Servers (DataServers)

A manual that  describes how  to configure and run Reliance's data servers (Reliance 4
Control Server and Reliance 4 Server). The document also includes a detailed description
of the Web pages provided by a built-in Web server. 

Web Client (WebClient)

A reference guide for Reliance 4 Web Client, which is based on the Java platform. The
document describes how to run and work with Reliance 4 Web Client.

Scripts (Scripts)

A  reference  guide  for  VBScript  and  Reliance  objects  used  to  access  elements  of  a
visualization project from scripts.
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OPC Tutorial (Tutorial_OPC)

A short tutorial that shows how to connect to an OPC server from a Reliance project. The
document  describes  the  process  of  creating  a  new  project  with  an  OPC  device  and
importing tags from an OPC server.

Data Exchange Methods (DataExchange)

A  document  describing various methods of  data exchange between a Reliance  project
and an external application  (CSV,  SQL,  DDE,  COM,  OPC,  External  Communicator,  Web
service).

Change Log (History)

An  HTML  document  containing  the  list  of  new  features  and  changes  made  to  the
Reliance SCADA/HMI system by version.

FastReport – Custom Reports (CustomReports)

A user's manual for the FastReport 4.0 tool, which is integrated in the Reliance SCADA/
HMI system. It is an original document that is only available in the English language.

Visual Basic Scripting (VBScript5)

An original Microsoft document containing a tutorial and a reference guide for VBScript.

Microsoft Windows Script Technologies (WindowsScript56)

An original Microsoft document containing user's guides for VBScript and JScript.
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